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1.0 General Information 
 

1.1 Introduction 

The Mini TDGP instrument is a compact, lightweight, plug-n-play sensor designed for 
measurement of gas tension (total dissolved gas pressure) in liquids.  The sensor 
operates through diffusion of gas from water through a hydrophobic membrane to an 
accurate and stable pressure sensor. 

Applications for this sensor include determining the N2 concentration in natural waters 
(in combination with an O2 measurement), measurements of groundwater dissolved gas 
saturation levels, proxy measurements of dissolved gases such as CO2 and CH4 in 
natural and industrial settings, and gas flux studies. 

Use caution when unpacking your sensor.  Check all the contents of your package 
immediately upon arrival and refer to the packing list to ensure all items are included 
with your sensor.  We recommend that you retain original packaging for future use.  If 
you suspect any items are missing or anything is damaged, please contact Pro-
Oceanus or authorized distributer immediately.   
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1.2 Warnings 

To prevent damage to your sensor, carefully read all deployment and operating 
instructions before using the sensor.  
 

 When opening the sensor, ensure the outside is completely dry and open while 
sensor is horizontal to prevent any water entering housing. 
 

 The membrane is the most important part of the instrument, great care must be 
taken not to damage it. 

 

 Do not use abrasive materials on membrane. 
 

 Use caution when unscrewing the instrument face plate, a screwdriver can easily 
puncture membrane. 
 

 When faceplate is removed, do not allow sensor to come in contact with 
water/spray with water. 

 

 When deploying vertically, ensure the head is facing down and no gas is trapped 
along the membrane. 

 

 Use caution when deploying in water that significantly colder than the air. 
Condensation of water vapor can occur inside the detector. 

 

 Caution removing the instrument when dissolved gas pressure is substantially 
above atmospheric pressure. Slowly bring the instrument to the surface under 
these conditions. 

 

 Hand-tighten cable connector locking sleeves, do not over tighten. 
 

 When using a pumped head, flow rates should not exceed 3 L/min. 
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1.3 Quick Start Guide 

Software Setup: 
1) Insert the Pro-Oceanus flash drive provided with your sensor into a computer 

operating Microsoft Windows 2000 or newer. 

2) Open the folder labelled “Software” 

3) Right click on    and copy and paste application to desired location on 

computer 

*The sensor will also run with Tera Term (free to download) as well as other terminal programs. 
 

Instrument Setup: 
1) Caution: Protect the membrane of the sensor from 

damage during testing and deployment 

2) Note: if the sensor has an internal battery, refer to the 

“Internal Battery Operation” below 

3) Connect the sensor to the communications/power deck 

box using the underwater cable with connector 

4) Ensure the correct dummy plug is connected to the 

battery ON/OFF bulkhead connector (if available) 

5) Connect the deck box to a Windows-based computer 

using an RS-232 serial cable or RS-232 to USB converter cable. Note: if using a 

Serial-to-USB converter, the correct driver must be installed for proper operation 

6) Apply 12 VDC power supply to the deck box through the barrel jack. It is 

recommended to use the AC/DC converter supplied with the deck box  

 
Open the terminal program on your computer and refer to “Sensor Configuration” below.  
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OPTIONAL Internal Battery Operation: 

1) Caution: The Mini TDGP sensor is designed to be powered using either a 7-24 VDC 

external input or the optional internal battery pack, but not both at the same time. 

2) To activate the internal battery power, connect the labelled “shorted plug” to the 

battery ON/OFF bulkhead connector to enable the battery. Ensure no external power 

supply is connected. If the external battery is not being used, connect the unlabeled 

dummy plug to the battery ON/OFF bulkhead connector. 

                         
 

3) For internal battery endurance, refer to Section 4.5 

 
Sensor Configuration 

1) After powering the sensor and connecting to a Windows-based computer, open 

the terminal program 

2) Configure the serial port settings (View > Terminal) to baud rate = 19200 and the 

correct COM port and click ok 

          
3) Program will open a terminal with a serial connection to the sensor, click the Start 

User Interface button, status banner and menu will appear. (Pressing ESC at any 

time will bring up the menu) 
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4) Enter “t” and set the sensor’s real-time clock. Once set, the sensor will keep time 

whether powered or not. 

5) Enter “3” to choose sampling method (continuous/timed/command) Note: if 

“timed mode” is chosen, the FIRST sample time must be at least 5 minutes after 

the current clock time that is set. Once configured, press “ESC” to return to the 

main menu. 

6) To begin sampling, press “1”. Data will be logged to the internal SD memory as 

well as transmitted via RS-232 to computer.  

Continuous Mode: sampling will begin within 10 seconds of selecting “1” 

Timed Mode: the sensor will wait until the pre-set first sample time before  

     outputting data 

Command Mode: a sample will be taken when “s” is pressed. In command  
                 mode, the user interface must be active. If there is no       

                  activity for 60 seconds, the RS-232 port will go to sleep  
                and can be activated by pressing any key followed by  
                 the “ESC” key.  

7) To stop sampling, select “2”. “2” must also be selected before switching sampling 

modes 

8) If using Oceanus View, data can be directly logged to the computer by clicking 

the Saved Logged Data button and selecting a location and name of the same 

file. In Oceanus View, data will only be saved from the moment the Saved 

Logged Data button was pushed.  
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2.0 Instrument Overview        
 

2.1 Sensor Checklist 

2.1.1 Standard Logging Model – P/N: G420-01 

Includes: 

- Mini TDGP Instrument 

- USB memory stick with Oceanus Software and User’s Manual 

- QuickStart Guide 

 

Recommended:  
Power and communications deck box (P/N: A10-103), includes:  

A.  Water-Resistant deck box with Underwater Cable and Connector Sleeve 
B.  2-meter RS-232 cable 
C. RS-232-to-USB Converter  

(FTDI-driver download available at: 
http://www.ftdichip.com/Drivers/VCP.htm) 

- AC to DC 12 V Power Supply 

 

 
 
 
 

http://www.ftdichip.com/Drivers/VCP.htm
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2.1.2 Logging Model with internal rechargeable AA battery pack – P/N: G430-01 

Includes: 

- Mini TDGP Instrument 

- USB Memory with Oceanus Software and User’s Manual 

- QuickStart Guide 

- Internal 6 VDC x 5 Ahr NiMH Battery Pack (D) – P/N: M230 (12 VDC for M235) 

- Battery Charger with Cable (E) 

 

 

 

2.2 Sensor Specifications 

Parameter Specification 

Accuracy + 0.1% (of maximum range) 

Resolution 0.002% of full scale  

Power Consumption 0.06 W (5 mA @ 12 VDC) 

External Input Voltage 7 - 24 VDC 

Signal Output Serial RS-232, CSV ASCII String 

Water Temperature Range -2 to 50˚C  

Detection Method MEMs Piezoelectric Sensor 

Housing Material Acetal Plastic (Titanium optional) 

Depth Rating 600 meters (up to 6000 meters optional) 

Equilibration (t63) Dependant on gas composition 

Weight Air: 0.53 kg        Water: -0.06 kg 
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P/N: G420-01 – No internal battery 

 

 
P/N: G430-01 –Internal battery 

 

 
  

280 mm (11”)

53.4 mm

(2.1”)

370 mm (14.6”)

53.4 mm

(2.1”)
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2.3 Optional Accessories 

 
Water-Pumped Head Assembly 
P/N: MA-30-01 
 

 

Copper Antifouling Head 
P/N: MA-301-01 

 

 
Replacement Copper Antifouling Shield 
P/N: MR-361-01 

 

 
Pelican Storm Hard Shell Case 
range of sizes available 
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Internal Battery Packs 
5 Amp-hour x 6 VDC rechargeable NiMH 
P/N: B500-6V 
 
5 Amp-hour x 12 VDC rechargeable 
NiMH P/N: B500-12V 
 
19 Amp-hour x 6 VDC non-rechargeable 
alkaline 
P/N: B600-6V 

 

 
Replacement Membrane 
P/N MR500-1  

 
 
External Battery Housings, Packs, and 
Cables 
 

 

 
Mooring Cage with Instrument Brackets 
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Pigtail Cables with Locking Sleeves 
2-meter pigtail cable with locking sleeve 
– P/N: C20-002M 
5-meter pigtail cable with locking sleeve 
– P/N: C20-005M  
10-meter pigtail cable with locking 
sleeve – P/N: C20-002M 
25-meter pigtail cable with locking 
sleeve – P/N: C20-025M 
50-meter pigtail cable with locking 
sleeve – P/N: C20-050M 
Other lengths available 

 

 
Mooring Frame with Instrument Brackets 
Titanium P/N: MA21-TI 
Aluminium P/N: MA21-AL  
 
  

 

2.4 Gas Concentration Ranges Available 

Standard Measurement Ranges   0 – 2 bar   

Optional Ranges:   0 – 5 bar 

     0 – 14 bar 

 

2.5 Customized Units 

Pro-Oceanus can provide customers with uniquely designed and/or modified Mini TDGP 
instruments. Customizations can take the form of various connector styles and water 
inlet/outlet ports, differing geometrical dimensions, variable concentration ranges, and 
modifications to the logging program, housing material, membrane thickness, and more.  
If you have a specific need, contact Pro-Oceanus to discuss possible solutions. 
 

3.0 Instrument Setup and User Interface  

 

3.1 Software Overview / Installation 

Software can be found on the USB stick included with the sensor or by contacting 

support@pro-oceanus.com.  

Software is compatible with PC-based computers running Microsoft Windows. The 

computer must be equipped with a serial port, or a USB port with appropriate drivers 

installed.  

mailto:sales@pro-oceanus.com?subject=Custom%20instrumentation
mailto:support@pro-oceanus.com
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Sensors will also run with Tera Term (free to download online) and other terminal 

programs.  

The setup of the communication port must be set as:  

Serial Communications 
Parameter 

Value 

Baud rate 19200 

Data bits 8 

Parity none 

Stop bits 1 

 

Installing the Pro-Oceanus software 

 

1) Insert the Pro-Oceanus flash drive provided with your sensor into a Windows-

based computer 

2) Open the folder labelled “Software” 

3) Right click on    and copy and paste application to desired location on 

computer 

 

 

3.2 Connecting the Sensor 

 
 

- Connect the instrument to the communication/power deck box (A): 
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- Connect the AC/DC power supply (D) to the deck box and plug into a wall outlet. 

- Connect the instrument to the computer with the supplied RS-232 Cable (B). Use 

the RS-232 to USB cable (C) if needed. 
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3.3 Serial Terminal  

- Open the terminal program. 

For Oceanus View: 

  - A home screen will open: 

  
 - Select the Terminal option under the View menu. 

 - The following communications port settings window will open:  

                      

 
  

 - Enter the correct baud rate (factory configuration is 19200) and 

COM port and click ok. 

 - The program will open a terminal with a serial connection to the 

sensor: 
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- Click the Start User Interface button, sensor will activate and a status banner 

and menu will appear. (There may be a slight delay) 

 

For Tera Term: 

 - Open Tera Term and a window will open: 

    
 - Select the serial option and ensure the correct port is selected. 

 - Click Ok 

 - Select the Serial Port option under the Setup menu and a window will open to  

   configure the serial port: 
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- Select the correct baud rate (19200) and ensure the port is correct. All other   

  settings should be correct.  

- Click Ok 

- Click “esc” to activate the sensor, a status banner will appear, click “esc” again 

and the menu will appear. 

 

3.4 Menu Overview 

Once connection with the sensor is established in the terminal program, the following 

status banner and menu will appear: 

 
 

The status bar shows the: 
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 Firmware Version 

 Set date and time 

 Detector ORT – the amount of time that the detector module connected to  

        the logger has been on and operating  

 Supply Voltage – measure of the main system power input 

 Mode – This is the current mode of measurement the sensor has been  

    configured for. This is changed in the main menu under Setup Sampling 

 

The Oceanus Controller is equipped with automatic sleep mode.  If no user interaction 

is detected within 60 seconds of powering the instrument, it will return to low-power 

sleep.  From the banner display press the “escape” key to enter the user interface.  If 

the 60-second user-interface timeout has occurred, press the any key to wake the 

sensor and then press “escape” to start the user interface. 

Menu options are selected by typing the preceding number or character. 

Pressing “escape” key at any point will return to the main menu. 

 

1) START sampling mode: Starts sampling in currently set mode 

2) STOP sampling mode: Stops the sampling 

3) Setup sampling: Start a different sampling mode 

This brings up a choice of sampling modes: 

  
   Continuous: Type ‘1’ to select continuous mode 

  This mode samples as often as the sensor can.  

(usually every few seconds) 

- After selecting continuous option, there is an option to log samples in intervals: 

 1) Number of continuous mode samples skipped between log entries (0) 

- To set this option, type ‘1’ and this message will appear: 

 Enter the number of continuous samples to skip (0-1125)>>  

- Enter a number between 0 and 1125 to set the number of samples to be 

skipped between logged samples 

- Then press Enter 

 

   Timed: Type ‘2’ from the setup sampling menu to activate timed mode.  

     Timed mode has three settings:  
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       Each can be selected by typing the number preceding the option. 

1) Sample interval in minutes: sets the amount of time between samples in     

                minutes (from 1 to 10080 minutes) 

  2) Number of readings per sample: the number of samples that are taken on  

                 every sample interval (from 1 to 20 samples) 

  3) First sample time: sets the time that the sensor will take its first sample (24hr) 

   - type hour sampling will start Enter hour (24 hour format)>> Press enter 

   - type minute sampling will start Enter minute>> Press enter 

   - type second sampling will start Enter second>> Press enter 

*ensure internal clock is correct before setting sampling time – option ‘t’ on 

the main menu 

 

  Command: Type ‘3’ from the setup sampling menu to activate command mode 

           Takes samples whenever prompted by the user  

(‘s’ command in main menu)  

 
  - Type ‘1’, prompt will appear: Enter the number of readings per sample (1-20)>> 

  - Type number between 1 and 20 and press enter 

  

4) View logged data: View data that is logged on the sensor 

When viewing logged data, the first two lines do not contain sensor data.  

The first line contains the column headings for the data and the second 

line contains the formatting information. To reduce the data download 

time, the baud rate can be adjusted to the maximum allowable rate. 

Viewing data will stop all logging data. Escape key can be pressed at any 

point to abort the download process 

5) Erase logged data: Erases data logged on the sensor 

- Prompt will appear: Are you sure you want to erase all data? (y/n) 

- Type ‘y’ to erase all data 

6) Print status banner: prints the status banner (firmware version, date and time,  

sensor’s run time, supply voltage, current sampling mode) 
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s)  Single sample acquisition in command mode: collects sample or series of  

   samples when in command mode 

t) Set clock time: sets the internal clock and should be set to current time (24hr) 

b)  Set baud rate: set the baud rate of the sensor, factory default is 19200 

f) Restore factory defaults 
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3.5 Data Output and Format 

The data is output and stored in the following format: 
 
P 2017,04,22,13,56,53,1007.774,21.263,12.0,2349,1821,0,0 
 

The data is in comma separated variable format (CSV) and the fields have the following 
meanings: 
 

Field number Description Value in example 

1 Start of data line (this is fixed and may be used to search for the 

beginning of the data on any line) 
P  

2 Year 2017 

3 Month 04 

4 Day 22 

5 Hour 13 

6 Minute 56 

7 Second 53 

8 Dissolved Gas Pressure [mbar] 1007.774 

9 Temperature [ºC] 21.263 

10 Supply voltage [volts] 12.0 

11 Analog input 1 [A/D counts] (0-4095) 2349 

12 Analog input 2 [A/D counts] (0-4095) 1821 

13 Digital input 1 [logic level] (0-1) 0 

14 Digital input 2 [logic level] (0-1) 0 

 
Each data line is terminated with a carrage return line feed, CRLF, sequence.  The 
resolution (number of digits after the decimal) is fixed for each field. 
 

 

 

3.6 Opening, Sorting, and Saving Data Files 

The following instructions are for opening, sorting and saving data files in Oceanus View 
software.  
 
Opening a File: 
 

- Click the open option under the File menu 

- Select the file you want to work with in the window that opens by double clicking 

it or selecting the file and clicking the open button (large files may take time to 

open) 

- A spreadsheet with the data will open  
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Sorting the Data: 
 
- Under the Filter menu, there are two options: 
 1) Sort Rows: 

- Select a column to sort in reference to 

- Select the desired sorting operation 

- Enter the value or range to sort in reference to (min/max) 

- Click ok 

- Save window will open  

- File can be existing file or a new file but cannot be the original file 

- Click save 

- New window will open with the sorted data 

 

                   
2) Sort Columns: 

- Select columns you want to keep  

- Date, time, and measurement columns are locked and cannot be removed 

- Click ok 

- Save window will open 

- File can be existing file or new file but cannot be the original file 

- Click save 

- New window will open with the sorted data 
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3.7 Graphing Saved and Live Data 

The following instructions are for graphing data using the Oceanus View software 

 
Graphing saved Data: 
 

- Open saved data to be graphed 

- Graph Selection window will open:  

 
- Select x and y axes from the drop-down menus 

- Select the number/range of points you want to graph (default is the entire range) 

- Click OK 

- A graph will be generated with auto-scales axis 

- To navigate back to the data, click data under the view menu 
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Manipulating the Graph: 
- When the graph is open, there is a format menu at the top with two options: 

- Labels: opens window to update the graph labels 

 
- Data Selection: re-opens the Graph Selection window 

- Save the graph with the Save option under the File menu 

- Print the graph with the Print option under the File menu 

Graphing Live Data: 
- Open terminal 

- Under the View menu, click the graph option 

- Graph Selection window will open: 

 
- Select x and y axis to be displayed on the live graph 

- Click OK and a blank graph will appear: 
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- In the terminal window, begin sampling 

- Points will appear on the graph once sampling begins 

- Options under the Format menu can be used while the live graph is running to 

manipulate the graph 

- If plotting with time as a variable, a graph line will form. If plotting with two other 

variables, a point graph will be created 
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4.0 Instrument Deployment  

 

4.1 Sensor Mounting and Plumbing   

The Mini TDGP sensor should be mounted horizontally when possible. This is to 
prevent any sediment buildup on the membrane as well as to prevent the trapping of 
any free gas against the membrane. If the sensor must be mounted vertically, it is 
recommended to have the membrane facing upwards for quick deployments and 
profiling, and with the membrane facing downward for prolonged moored deployments. 
When deploying the sensor with the membrane pointing downward, it is recommended 
to initially place the sensor horizontally to allow any gas next to the membrane to be 
removed by buoyancy. Below is an image of the sensor and the preferred location of 
mounting brackets. 

 

If the water-pumped flow-through head is installed (Section 4.6.1) and connected to a 
water pump, ensure that water is pushed through the sensor head and not pulled. 
Pulling water through the sensor head can alter dissolved gas pressure and potentially 
damage the sensor membrane. 
 

4.2 Moored/Stationary Mode 

When the sensor is configured in timed or command mode, it can be used for extended 
periods of time on moorings and stationary platforms. When deploying the Mini TDGP 
sensor in moored mode, it is important to ensure gas bubbles do not become trapped 
against the sensor membrane when first placed into the water. Having the sensor tilted 
horizontally or vertically with the membrane pointing upwards can facilitate this. The 
sensor should be mounted in a horizontal position for long-term deployments to prevent 
buildup of particles on the membrane. Vertical mounting is acceptable as well provided 
the sensor membrane is facing downward and there is no potential for gas bubbles to 
rise and become trapped against the membrane surface where it is deployed. While the 
gas bubbles will dissolve over time, they will create irregular data when present. 
 

4.3 Profiling/Underway Mode  

When the sensor is configured in continuous mode, it can be used for short periods of 
time on profilers and mobile platforms, or longer periods with a dedicated power supply. 
When deploying the Mini TDGP sensor in profiling mode, it is essential to ensure gas 
bubbles do not become trapped against the sensor membrane when first placed into the 
water. Having the sensor tilted horizontally or vertically with the membrane pointing 
upwards can facilitate this. The sensor can be mounted in any orientation provided that 
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gas bubbles are not trapped against the membrane during the initial time of deployment. 
The sensor does have a significant equilibration time when compared to typical CTD 
instrumentation. This requires the user to stop at pre-determined depths for 15- 20 
minutes to allow for full equilibration. The use of a water pump with the water-pumped 
sensor head will reduce the time to equilibrate and it is highly recommended to minimize 
the duration of a profile. 
 

4.4 Integration with Existing and Third-Party Systems  

Pro-Oceanus works with many third-party companies to integrate our products into their 
platforms and equipment. If you have a system or platform that you would like to have 
the Mini TDGP sensor integrated into, please contact us. 
 

4.5 Power Budgets   

The Mini TDGP can be operated using direct cable power input, an external battery 
pack, or an optional internal battery pack (outline above).  The average power 
consumption for the Mini TDGP is approximately 0.06 W (5 mA @ 12 VDC) when on 
and the serial connection is open.  The internal controller requires ~40 µA of current 
during sleep.  

As an example of the optional internal battery endurance, using a 5 Ahr battery would 
provide more than 50 days of data in continuous mode. In timed mode, the same 
battery could take a measurement of 10 samples every 5 minutes for more than a year. 
 

4.6 Installing Optional Accessories 

4.6.1 Water-pumped flow-through head  

(P/N: MA-30-01) 

The water-pumped head provides a reduced time for sensor equilibration with a 

surrounding water sample and an effective means of preventing biofilms from forming 

on the membrane. 

 

 

1

3

2
Side View Face View

Water In

Water Out

Sensor Interface

Faceplate Pumped Head Assembly

Flow-through Gap

4-40 x 3/4” long

1/4” Tube Fitting

Mini-Pro Series Water-Pumped Head Interface

Part Number: WPH-M-01

Installation and water flow diagram
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To install the water-pumped head: 

1) Remove three of the socket-head screws (1/2”) in an alternating pattern. Do 

not loosen the three remaining screws as this will compromise the instrument 

integrity. 

 

2) The pumped-head assembly will fit directly on top of the three remaining 

socket head screws. (Make sure O-ring on pumped-head is in place – 

indicated by red arrow below). 

3) Ensure the pumped head is flush with the sensor head and insert and hand-

tighten the three screws that are supplied with the pumped head (3/4” length). 

4) Once the pumped head is gently resting on the O-ring seal, creating a small 

and even gap between the pumped head and the sensor head, the three 

screws can be tightened using the supplied 1/32” Hex screwdriver, alternating 

each screw tightening a quarter turn each time until pumped head is securely 

connected. *Do not overtighten 

 

 
 

The pumped head is also supplied with a 30 cm piece of silicone tubing for connecting a 

small, user-supplied water pump to one of the ports of the water pumped head.  The 

recommended water rate is 0.5-3 liters per minute when using the water-pumped head 

accessory.  Higher flows may abrade the membrane more quickly and should be 

avoided. 
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4.6.2 Antifouling copper faceplate  

(P/N: MR-361-01) 

Installation of the antifouling copper faceplate can discourage the growth of organisms 

on the sensor’s membrane.  

To replace the copper face plate: 

1) Dry the sensor and place it horizontally on a clean surface. 

2) Using a 3/32” Hex screwdriver, remove the screws 1-6, use caution as slipped 

screw driver can damage the membrane. This will remove the entire faceplate 

and the membrane will come loose, carefully set the membrane aside.  

 

3) Remove screws 7 & 8 to separate 2 sections of faceplate 

4) Replace copper screen 

5) Place O-ring on top of copper screen  

6) Place top part of faceplate on top of O-ring. 

     

7) Re-install screws 7 & 8 (1/2” length). 

8) Ensure O-rings are in place (one on instrument body and one on back of 

faceplate) 
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9) Holding the sensor vertically, carefully put membrane on sensor head. Place the 

faceplate on top and replace screws 1-6. It is recommended to install all six 

screws and tighten until the O-ring begins to compress. It should not be difficult 

to tighten the screws. If excess resistance is felt, ensure the membrane and O-

rings are in the correct position. Hand-tighten screws, do not over-tighten. Then 

alternate sides and tighten each screw with a quarter turn each to install the 

faceplate evenly. 

 

 

4.6.3 External battery pack 

Pro-Oceanus Mini Series sensors can be connected to an external battery power supply 

where long deployment periods with frequent sampling are required. Pro-Oceanus can 

provide external battery housings and battery packs along with the appropriate cabling 

for simple connection and operation. 

For external battery power, use the power/comm deck box (A10-103), configure the 

sensor to the desired sampling setup and press “1” to start the program. Ensure that the 

clock time is correct and that the first sample time is at least 20 minutes after the current 

time. If the first sample time is set too close to the current time, the sensor will not start 

collecting data until the next day. Once the program is set and started, remove the 

deckbox cable from the Mini sensor. 

The below images are shown for a Mini sensor with internal battery pack (M230/330 or 

M240/340 series) being connected to a large external battery housing with pack 

(BH268-01). The same connections would occur for other Mini series and smaller 

external battery housings with packs. 

For Mini sensors that have an internal battery pack, ensure that the shorting plug is not 

installed on the battery bulkhead connector on the rear of the Mini sensor. Please use 

the supplied dummy plug. 
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The rear of the external battery housing has a 2-pin female bulkhead connector (V+ and 

Gnd). 

 

To connect the external battery housing to the Mini sensor, remove the dummy plug 

from the power/comm 4-pin male bulkhead on the rear of the sensor. 

 

The Mini sensor is connected to the external battery housing using a 4-pin female to 2-

pin male cable (CB40-01). 
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First, connect the 4-pin female end of the cable to the 4-pin male bulkhead on the rear 

of the Mini sensor. 

         

Next, connect the 2-pin male end of the cable to the 2-pin female bulkhead on the rear 

of the battery housing. 

 

Once connected, the sensor will be powered via the external battery pack. 
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4.7 Charging the Internal Battery (if installed) 

The interal battery pack for the Mini series can be charged using the charger and power 

source included with your sensor.  

1) Locate the Turnigy Accucell 6 charger (A) the charger power supply (B) and the 

connector cables (C). 

 

2) Remove the instrument from the water and dry completely. 

3) Place the instrument on a clean, dry bench and sure in place to prevent rolling. 

4) Disconnect the deckbox connection and or/shorting (or dummy) plug(s) from the 

instrument. 
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5) Connect the power supply to the charger. Connect the cables together and 

connect the charging leads to the corresponding outputs that are marked on the 

charger. [+] is red and [-] is black. (the power supply can be connected to 110 or 

220 VAC).  

 
Screen should read: 

 

6) Choose the correct battery type: 

- push the TYPE/STOP  button 

 
- hit the STATUS/+- button to scroll through the battery types 

- scroll to the NiMH battery and hit the START/ENTER button to select 

7) The following screen should appear: 
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If it does not read ‘charge’ next to NiMH use the STATUS/+- button to scroll through the 

options until the ‘charge’ appears. Push the START/ENTER button to select.  

8) The number in front of the A should be flashing. This is the amount of current the 

battery will charge at. This must be set to 0.3 for the Mini sensors. Use the 

STATUS/+- button to scroll to the correct number. Hit the START/ENTER button 

to select.  

9) Push and hold the START/ENTER button. This screen will appear: 

 
 and then charging will begin: 

 
- The timer shows how long (in minutes) the battery has been charging.  

10)  When charging is complete, the charger will beep and the screen will read:

 

*note The charger may time out part way through charging, the END:FINISH 

screen will appear but the V will be less than the charged battery (i.e. 4.52V for a 

6V battery). If this happens, restart the charger from step 6 to continue charging. 

11)  Disconnect the battery and power down the charger by unplugging it from the 

power source.  
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5.0 Care and Maintenance 

 

5.1 Cleaning 

5.1.1  Instrument Housing  

The standard Mini TDGP instrument is made of acetal plastic. Upon recovery, rinse the 

external surface of the sensor with clean, fresh water.  Mild detergents may be used to 

help remove biofilms.  Diluted Alconox Liquinox is a recommended detergent.  A soft 

cloth can be used on the housing to remove larger and more difficult to remove biological 

material.  

5.1.2  Bulkhead Connectors 

Unplug all cables and dummy plugs from the rear of the housing and inspect the 

connectors for corrosion.  Apply a light coat of silicone-based grease to each of the 

connector pins.  Dow Corning Molykote 111 is recommended.  Re-connect electrical 

cables and plugs and ensure the lock-down sleeves are secured.  Do not over-tighten 

the locking sleeves, hand tighten only. 

 5.1.3  Membrane Interface 

Cleaning of the interface should be completed after any deployment to ensure fast 

response times of the instrument as well as to prolong the service life of the membrane.  

Diluted Alconox Liquinox is recommended.  Using a small bucket filled with Liquinox 

diluted in clean fresh water, place the sensor in the bucket with a small water circulation 

pump.  Pumping of the liquid directly onto the membrane surface will help reduce the 

time of cleaning.  At all times, ensure that the membrane is not touched or damaged 

during cleaning. 

 

5.2 Replacing the Membrane 

1) Dry the sensor and place it horizontally on a clean surface. 

2) Using a 3/32” Hex screwdriver, remove the six screws from the face of the sensor: 
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CAUTION: Be careful not to damage the membrane, the hex driver can easily puncture 

the membrane if it slips.  It is recommended to alternate sides when removing the 

screws to release the faceplate evenly.  *Note: If the anti-fouling option is installed, 

leave the two screws shown below in place when replacing membrane.  They can be 

removed if the anti-fouling screen needs to be replaced.  

 

3) Once all six faceplate screws are removed, gently twist the faceplate while pulling        

away from the sensor body.  

4) Place the faceplate on a clean flat surface with the inside facing upwards to prevent 

scratching of the O-ring and O-ring groove. 
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5) Remove the damaged membrane and inspect the membrane support for any 

indication of water.  

Note: If the membrane has been damaged and water intrusion into the sensor 

has occurred, the sensor potentially needs to be returned to Pro-Oceanus 

Systems.  Refer to the Troubleshooting Section. 

6) Inspect the two faceplate O-rings (indicated by the grey arrows in above photo) and 

replace if necessary. The inner O-ring replacement size is 026 and the outer O-ring size 

is 029.  Very lightly grease each O-ring. Dow Corning Molykote 111 is recommended. 

7) Holding the sensor housing vertically, place a new membrane into the sensor head 

(ensure the shiny side is facing out).  

Note: Use an uncoated rubber glove or Kim-Wipe to place the membrane so that 

no oil residue or dirt ends up on the membrane. 

8) Re-install the six screws securing the faceplate of the sensor.  It is recommended to 

install all six screws and tighten until the O-ring begins to compress. It should not be 

difficult to tighten the screws. If excess resistance is felt, ensure the membrane and O-

rings are in the correct position. Hand-tighten screws only, do not over-tighten.  

Then alternate sides and tighten each screw with a quarter turn each to install the 

faceplate evenly.  

9) After installation, test the sensor in freshwater for several hours while monitoring the 

sensor signal.  This is to ensure that the membrane is installed properly and no leakage 

into the detector is occurring. If the sensor output becomes erratic or begins to output 

zero or negative values, immediately remove the sensor from water and refer to the 

Troubleshooting Section. 

 

5.3 Internal Clock Battery Replacement 

The Mini TDGP sensor uses an internal battery to power the logger/controller when not 

powered externally. This allows for the clock to remain active and accurate when not in 

use, or between measurements when external power is removed. It is recommended to 

replace the clock battery once every three years. 

1) Dry the sensor and place it horizontally on a clean surface. 

2) Remove the four screws on the side of the sensor head with a Philips screwdriver. 
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3) Gently slide the head out from the body of the sensor.  There will be some resistance 

from the O-rings, but do not pull hard or electronics could be damaged. 

 

4) Carefully pop out clock battery and replace. 

 

5) Inspect the O-ring (indicated by the grey arrow in the photo below) and replace if 

necessary. O-ring replacement size is 220.  Very lightly grease each O-ring.  Dow 

Corning Molykote 111 is recommended. 
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6) Slide head back into body, line up screw holes and replace screws.  

 

 

5.4 Calibration  

Calibration of the Mini TDGP must be completed by Pro-Oceanus staff. Multiple 

calibrations are made in sequence to ensure the best possible accuracy. 

It is recommended that each Mini TDGP to be returned to Pro-Oceanus once every 3-4 

years for re-calibration and functional testing.  Normal sensor drift over one year is 

typically less than 0.1% of the maximum measuring range. 

To return an instrument for re-calibration, please contact Pro-Oceanus for an RMA 
number prior to shipping it freight pre-paid to Pro-Oceanus: 

 

Pro-Oceanus Systems 

80 Pleasant Street 

Bridgewater, NS, CANADA 

B4V 1N1 

 

Carefully package the instrument in its original protective case, and clearly mark as 

“fragile goods” and “return for repair” on the outside of the case. 
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6.0 Troubleshooting 
 
There is no power going to the sensor. 
Check the power supply, it should be 7-24 VDC. 
Check the fuse in the deckbox and replace if necessary.  

 
Fuse is a 1.5Amp Slo-Blo 326 Series.  
 
The sensor is outputting erratic, zero or negative values. 

• The membrane may be damaged and water has entered the infrared detector or 

electronics. 

• The sensor may be experiencing pressure waves due to turbulent waters when 

the membrane is not compressed flat against its support. 

The sensor’s membrane is damaged and water has entered the detector. 
If a liquid other than fresh water has entered the sensor: 

• Contact Pro-Oceanus for an RMA to return the instrument for repair. 

If it is fresh water that has entered the sensor: 

• Dry the sensor completely and remove the sensor membrane as outlined 

in section 5.2 of the user manual. Then, place the sensor in a sealed 

container or bag with a drying agent such as Drierite. Ensure the drying 

agent is placed inside of a filter bag to avoid dust and particles from the 

drying agent to enter into the detector. Leave the sensor to dry for a 

minimum of 24 hours before attempting to power the sensor. After 

powered, check the sensor in air to see if it is behaving normally. If so, 

install a new membrane and continue to use. If the sensor does not 

operate normally, contact Pro-Oceanus for an RMA to return the 

instrument for repair. 

 
Symbols or dots are appearing in the terminal program, or sensor does not seem 
to be communicating with the terminal program. 
Check to make sure all cords are connected. Ensure that the baud rate of the sensor 
matches the baud rate set in the terminal program.  
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7.0 Warranty 

 

Pro-Oceanus Mini Series instruments are covered by a 1-Year Limited Warranty 

For a period of one year after the date of original shipment, products manufactured by 
Pro-Oceanus Systems Inc. are warranted to function properly and be free of defects in 
materials and workmanship.  Should an instrument fail during the warranty period, please 
contact Pro-Oceanus for an RMA number prior to shipping it freight pre-paid to Pro-
Oceanus: 

Pro-Oceanus Systems 

80 Pleasant Street 

Bridgewater, NS, CANADA 

B4V 1N1 

 

Carefully package in the instrument’s original protective case, and clearly mark as 
fragile goods and return for repair on the outside of the case. 

Pro-Oceanus Systems Inc. will repair it (or at the company’s discretion, replace it) at 
no charge, and pay the cost of shipping it back to the customer. 

 

Modifications / Exceptions / Exclusions 

1 Gas permeable membranes, rigid permeable membrane supports, support 
screens, absorbents, batteries, and other consumable/expendable items are not 
covered under this warranty. 

2 Damage to the sensor or other internal electronics as a result of flooding from 
either a punctured membrane or an improperly customer installed O-ring seal is 
not covered under this warranty.  Care must be taken to deploy instruments 
according to procedures described in this manual to minimize the possibility of 
instrument flooding. 

3 Corrosion damage is not covered under this warranty 

4 Welded mounting tabs and other mechanisms used to mount Pro-Oceanus 
Systems Inc. instruments to ships, buoys, mooring lines etc., are not covered 
under this warranty.  Pro-Oceanus Systems Inc. expects the best and safest 
engineering practices to be applied by knowledgeable and experienced persons 
during the deployment and recovery of instruments and cannot be held liable 
for any injuries or damages incurred during use of Pro-Oceanus instruments. 

This warranty is void if the instrument has been damaged by accident, mishandled, 
altered, or repaired by the customer where such treatment has affected its performance 
or reliability.  In the event of such abuse by the customer, repair costs plus two-way 
freight costs will be borne by the customer.  



Pro-Oceanus Mini TDGP User’s Manual 

 
 

Revision 2.0.3 2019-12-18 44 

APPENDIX A: Equilibrium Dynamics and Instrument Response Time 
 
The equilibrium of dissolved gas sensors with surrounding water requires diffusion of 
molecules from a liquid across a semi-permeable membrane to a gaseous headspace.  
Once in the gas phase, detectors are used to measure a concentration in gaseous form.  
Several factors affect the time it takes to equilibrate a gas headspace with a 
surrounding water parcel through a semi-permeable membrane.  The main factors are 
described below. 
 
There is a finite time that is required for the shift between the dissolved and gas phases 
of a substance due to the kinetics of solubility.  The rate is dependent on temperature 
and salinity, and to a much lesser degree, pressure. 
 
The membrane effect can be described using the Laws of Diffusion, whereby the 
diffusion coefficient of the semi-permeable membrane is a function of the gas solubility 
coefficient in the membrane, and the permeability of that gas through the membrane. 
   
The thickness of the membrane also plays a crucial role in the time for equilibration. 
 
Temperature and salinity can dramatically affect the diffusion through a membrane. 
 
The equilibration rate of diffusion processes is often measured in terms of a time 
constant, t63.  This represents the time it takes reach 63% of equilibrium.  The flux of 
gases across a membrane is a function of the gradient of difference between the 
concentrations on either side of the membrane.  For example, the flux of a gas across a 
membrane will be rapid when the difference in concentration in surrounding water and 
the gas headspace is large.  As a gas moves across the membrane either into or out of 
the gas headspace, the concentration gradient decreases, and as a result, the rate of 
gas flux across the membranes slows. 
 
The concentration gradient across the membrane continually changes, and the resulting 
change in concentration of a particular gas in a headspace can be described 
mathematically as a logarithmic function.  Below is a graph that illustrates the change in 
concentration in the headspace of an instrument using a semi-permeable membrane to 
equilibrate.  The graph also shows commonly used time constants used in industry, t63, 
t90, t95.  
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t63 is taken as one fifth of the total time to equilibrate,  
t90 is approximately half the time to equilibrate, and 
t95 is roughly 60% of the time to equilibrate. 
t99 is taken as teq. 
 
The time constant, t63 is commonly used and is the number referred to by Pro-Oceanus.  
There is also the effect of the water-side boundary layer. Advection transfers the 
dissolved gas to near the membrane surface is a rapid process, but diffusion of gas 
through the water boundary layer is the rate limiting factor in the transfer from the water 
to the outer surface of the semi-permeable membrane. Temperature once again has a 
major effect on the diffusion rate. In all cases, warmer temperatures improve the 
response time of the instruments, while cooler waters will slow the process. 
The thickness of the boundary layer can vary (and as a result, so too does the time to 
diffuse through the boundary layer) and the thickness is determined by the 
hydrodynamics next to the membrane surface. Stagnant water will produce the thickest 
boundary layer, resulting in the slowest response time. Maximizing the water shear 
across the membrane surface will reduce the boundary layer thickness to a minimum 
and is recommended using a Pro-Oceanus pumped head assembly.  The effect of high 
shear also reduces the potential for biofouling of the instrument. 
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